ICWAR 2014

Women and Homelessness in Spain

María Rosario H. Sánchez Morales*

UNED-GETS, Madrid, Spain.

Abstract

This work focuses on the situation of homeless women in present-day Spain. This constitutes both a social and a personal problem embedded in the dynamics of social exclusion and linked to the interplay among structural, family/relational, personal and cultural elements. Although homelessness is mainly a male phenomenon, it also affects 3,000 women, including both women living in welfare facilities for this purpose and those who literally sleep in the street. In the present context, "traditional" homeless people share their condition with new and diverse types of homelessness forming a continuum of processes and trends of social inclusion vs. social exclusion. Within this continuum, the increasing presence of women amongst the excluded, marginalized population is especially relevant.

© 2014 The Authors. Published by Elsevier Ltd. This is an open access article under the CC BY-NC-ND license (http://creativecommons.org/licenses/by-nc-nd/3.0/).

Peer-review under responsibility of the Organizing Committee of ICWAR 2014.

Keywords: homeless women; homelessness; extreme social exclusion.

1. Introduction

Homeless women constitute an extreme case of social exclusion. Their life circumstances are the result of a complex intertwining of experiences, deficiencies, failures, frustrations and difficulties which funnel them into a tunnel of vulnerability at the end of which they find themselves living in the street. It is in this social group where the most radical, defining elements of social exclusion appear in the most clear, broad and profound way. It is a group that “… is excluded from the life opportunities which define full social citizenship in present societies” (Tezanos 1998).

* Corresponding author.

E-mail address: mmsanchez@poli.uned.es

1877-0428 © 2014 The Authors. Published by Elsevier Ltd. This is an open access article under the CC BY-NC-ND license (http://creativecommons.org/licenses/by-nc-nd/3.0/).

Peer-review under responsibility of the Organizing Committee of ICWAR 2014.

Both conceptually and analytically, the problem of homelessness among women falls within the logic of social exclusion processes and the emergence of a “second-class” citizenship, a type of process which is so present in modern societies that some analysts have even spoken of the rising of a “new social issue” (Sen 2000). Homeless women do not enjoy full political, social and civil rights and may be categorized as “infra-citizens” belonging to the “infra-classes”. This involves a condition of social isolation and uprooting which is representative of the paradigm of negative individualism (Peace 2001).

In consequence, homeless women are left outside “social consensuality”, with a modus vivendi of basic survival. They are linked to elements of social deviation, victims of social segregation and associated with a strong component of social stigmatisation (Phelan, Link & Stueve 1997).

The difference between the dynamics of their life and that of other female groups also associated with elements of social deviation, isolation and differentiation lies in the difficulties posed by their rehabilitation.

In order to visualize homelessness in general, and homelessness among women in particular, we may use a helicoidal graph representing the fact that women’s social life, social presentation and personal projection are the result of the interaction of structural, family/relational, personal and cultural factors, as we shall discuss below. Especially in convulsed societies like ours, the social helices in the figure may reach such a movement that women are expelled at great speed from its interior onto the fringes of society (see Fig. 1).

![Fig. 1. The helicoidal shape of homelessness.](image-url)
2. The sociological notion of homeless Illustrations

In Spain, the terms “transient” (of no fixed abode), “homeless”, “roofless” and “destitute” are often used indistinctly to refer to the social group lacking a home, a frame of social insertion of their own or a fixed place of residence.

Until the 1970s, such people were described as “vagabonds” and “idlers” in the context of rural, pre-industrial Spain, and theirs was a rather masculinised milieu. Subsequently, it was considered necessary to redefine these terms in order to suppress the element of social stigma that they involved, and the term “transient” was widely adopted. A transient person is defined as someone, a man or a woman, who is “in transit”, who roams from place to place, from one institution to another, with no other possessions than those they carry with themselves, and who keeps looking for work or help with the only aim of short-term survival. At that moment, the term “destitute” also came into use to refer to this population, and it is often still used in the media.

In the 1970s, the transient condition was mostly associated with domestic migration. In the 1980s, however, within the framework of a recently modernized and industrialized Spain, economic crisis and unemployment lent the transient population new characteristics and new profiles appeared within them. Thus, a new conceptualization of the phenomenon became imperative. It was then that the terms “homeless” and “roofless” were introduced to refer to new types of marginalized social groups, bringing to the foreground their lack of a home or a fixed residence as a defining feature. Both new terms comprise within a single category everyone who, lacking a home, lives on the streets or in night shelters while they are unable to find a place to live; their sedentary, more stable aspect clearly differentiating them from the “transient” person typical of earlier times. Thus, in large cities, "transient" people share their space with “homeless” or “roofless” people, it being the number of the latter that has increased significantly over the last decades (Cabrera 1998).

Here we shall advocate the use of the “homeless” notion in order to highlight the fact that homeless people are not only affected by the lack of a fixed place of residence, but they also suffer from severe deficiencies and shortcomings derived from their lack of participation in the community relations established within the framework of a household, which for household members, and especially in the case of women, constitute the main source of a strong feeling of confidence and appreciation. As a consequence of all this, both for cultural and ideological reasons, the situation of homeless women gravely deteriorates after having lost their emotional refuge, the social niche where they could take haven and organize the network of interests and relationships on which to build their own identity both as women and social subjects.

It is not easy to estimate the precise number of women affected by extreme social exclusion due to the lack of studies at hand. Nevertheless, we can calculate that they represent between 11 and 19 percent of the total homeless population in Spain. There are about 30,000 homeless people in Spain, and 6,000-6,500 of them live in the streets (1,200-1,500 women). According to available statistics, 20,938 homeless people were attended in night shelters and meal centres in 2012; 2,000 of them were women (INE 2005, INE 2009, INE 2012, Ayuntamiento de Madrid, 2012).

3. Factors of exclusion in processes leading to homelessness amongst women

The condition of “homeless” women is the result of multiple interrelated processes. While adopting this type of perspective of the phenomenon, we may consider that, strictly speaking, “being without a roof” means, literally, lacking a place to shelter. Thus, we are faced with a situational problem related to housing. From this point of view, homelessness would relate to housing prices, fiscal policies, home rental policies, income distribution policies, pensions and other types of social benefits, and, obviously, to welfare regulations, which provide (or not) access to housing to specific social groups provided they fulfil certain conditions. Therefore, from this situational perspective, access to housing would be the key determining factor of homelessness.

However, if we want to overcome such a restrictive view of the homeless phenomenon, we must also take into consideration other structural factors (employment policies, equal opportunity policies, social policies for vulnerable groups, educational policies, vocational training policies, immigration policies…), as well as other personal and relational elements, and certain issues associated with the value system in our society (see Table 1).
Table 1. Structural, Family/Relational, Personal and Cultural Factors Involved in Women’s Homelessness

<table>
<thead>
<tr>
<th>Structural Factors</th>
<th>Family/Relational Factors</th>
<th>Personal Factors</th>
<th>Cultural Factors</th>
</tr>
</thead>
</table>
| - Employment policies  
- Housing policies  
- Educational/Training policies  
- Equal opportunity policies  
- Fiscal policies  
- Income distribution policies  
- Pensions and minimal income  
- Social regulations  
- Immigration policies  
- Social welfare policies  
- Effects of the economic crisis and restructuring  
- Social policies regarding vulnerable and socially excluded groups (women at risk of experiencing social difficulty) | - Weak family ties or lack of them  
- Family conflicts and breakups (separation, divorce)  
- Family circumstances (widowhood, orphanage)  
- Lack of friendship networks and circles  
- Social uprootedness  
- Isolation  
- Bonds to mafias (human trafficking) | - Gender  
- Personality  
- Age  
- Marital status  
- Social status  
- Ethnicity  
- Language  
- Nationality  
- Alcoholism  
- Drug addiction  
- Ludomania  
- Health condition (physical and mental)  
- Violence and abuse  
- Police record  
- Learning difficulties  
- Lack of social skills  
- Low self-esteem  
- Passive attitude; quick acceptance of the situation  
- Pessimism, fatalism  
- Depressive disorders  
- Weak motivational structure | - Individualism  
- Lack of solidarity  
- Competitiveness  
- “Social Darwinism” |

The personal factors involved in the condition of homeless women include: personality, gender, age, status, nationality, ethnicity, health (both physical and mental), some behavioural disorders (alcoholism, drug addiction…) (Johnson, Freels, Parsons & Vangeest 1997), as well as specific problems of gender-based violence and abuse which, in many cases, have been directly experienced. Family and relational factors involve conflicts, disruptions and breakups: widowhood, separation, divorce or breaking up with relatives and friends (Muñoz, Vázquez & Vázquez 2003).

Thus, we see that the study of the reality of homelessness requires a multidimensional analytical model which connects it to issues of social inequality, as well as with both relational elements and personal conditioning (Burchardt 2006).

Life experiences should be framed within a Social Vulnerability Theory, according to which there are specific groups and individual characters that are more socially vulnerable, and this in turn leads to the pre-eminence of certain factors, which display a more direct influence in the phenomenon of homelessness. Among these, we should highlight unemployment, lack of housing and/or family, unfavourable family environment, to which we could also add the presence of abuse, a factor that, as we have already stated, often becomes the cause or consequence of family breakup.

In this context, the convergence of structural, personal, family and relational factors leads to the profile of a solitary person with a broken family and social bonds and socially uprooted, to the point of having lost all juridical and administrative references.
While there are many life experiences that may lead to this situation, the fact is that homeless women reach a point where they find themselves alone, with no support; some of them even literally dying on the street.

In any case, female processes of exclusion are most often associated with household violence and conflicts with the partner, while male ones are more related to lack of resources, unemployment and poor health.

Following this factual analytical frame, the seriousness of homeless women’s problems varies in accordance with the different degrees of uprootedness they experience. Table 2 provides a summary of such problems.

Table 2. Principal Problems of Homeless Women

| - Without housing       |
| - Severe lack of resources |
| - Unemployment or marginal employment |
| - Uprootedness and social isolation |
| - Stigmatization |
| - Severe personal de-structuring |
| - Disability and poor health (both mental and/or physical) |
| - Health-care problems |
| - Lack of minimum order in life |
| - Life disruptions |
| - Dependence on social services |
| - Legal recognition |
| - Social services neglect |

4. A typology of homeless women

From a historical point of view, exclusion processes are subject to changes which have actually given rise to the existence of old and new types of homeless people, despite the fact that the life experiences of both types may be rather similar. In Spain, in line with the rest of the European countries (FEANTSA 2012), homelessness is still an essentially masculine phenomenon, although, in the last decades, new social groups have joined and, especially, groups including young and middle-aged women (see Table 3). It must be pointed out, however, that in the Mediterranean countries, families tend to intervene more frequently in the case of women than they do in the case of men in order to avoid their fall into the homeless condition (Sánchez Morales 2010).

Table 3. Main Sociological Profiles of Homeless Women in Spain

| - Young and middle-aged divorced or separated women, and/or victims of abuse |
| - Young and middle-aged drug-dependent or ex drug-dependent women |
| - Women who have been institutionalised in closed facilities (juvenile detention centres, prisons, hospitals) |
| - Young university students |
| - Squatters |
| - Women suffering from mental illness |
| - Women suffering from personality disorders |
| - Women with mental disability |
| - Immigrant women |
In recent years, though, increasingly more young people are being drawn into homelessness as a result of, amongst other reasons, the new dynamics of employment and the increasing difficulty in gaining access to housing, which only reinforces the more general difficulties young people are facing in order to attain satisfactory social integration.

On the other hand, we find an emerging group of drug-dependent young women in their thirties in a process of uprooting similar to that of their alcoholic male counterparts. The situation of these young women can acquire clearly dramatic overtones, since many of them have children to support and end up turning to prostitution for survival (especially in the first steps of their process of social exclusion).

Another social group that must be added to the homeless women population is that of mentally sick women who, since the deinstitutionalization of psychiatric patients in 1985, can be seen in the streets of the big cities.

There is also an increasing presence of young and middle-aged women as a consequence of the effects of divorce, separation, sexual abuse or gender-based violence. The problems of these women are even worse when they have children to support—although the special idiosyncrasy of Spanish families often spares them such an extreme situation. There is evidence that this social group displays worse psychological states than other groups, obviously due to the fact that they have been expelled from a more protective social and cultural environment where they used to be the support of the household. Thus, due to the traditional role of women in the support of the household, being a woman and living in the streets represents a double exclusion, one which is very difficult to evade, and on many occasions it is also possible to listen to a self-blaming discourse in the face of adverse circumstances.

If, as some experts point out, we are actually experiencing a transformation of the Spanish family moving it increasing closer to other cultural patterns with more individualistic traits, we may see an increasing number of homeless women and families with children to support in the short and mid-term.

Finally, we must point out that we are witnessing the return to the streets of elderly homeless women, as the network of retirement and nursing homes is not covering vulnerable elderly women, who tend to display a high level of resignation in the face of their situation (Sánchez Morales 1999).

5. Conclusion

In this text, we have dealt with the situation of homeless women in Spanish society at the beginning of the 21st century. Women's homelessness is a phenomenon which, both conceptually and analytically, should be inscribed in the dynamics of the processes of social exclusion presently taking place in all the societies within our socio-cultural space. It is true that there have always been people (mainly men) who, due to their own life paths, have lived in ‘non-regularized’ environments, according to a socially constructed dichotomy of exclusion vs. inclusion. For them, educational, economic, cultural, personal and social variables tipped the scales in one direction or another. However, in the last decades, we are increasingly witnessing the incidence of factors of exclusion and its consequences related to gender.

The problem of homelessness is actually the result of several interrelated circumstances, the understanding of which obliges us to take into account a whole array of structural, personal, family/relational and cultural elements. Consequently, a multidimensional model is required in order to analyse the multiple variables which currently affect women in especially difficult situations. According to the available information for Spain, homelessness currently affects about 3,000 women, including both those users of the specific recourses for this population and women living in the streets.

When it comes to defining the sociological profile of homeless people, we should distinguish between the traditional categories of homeless people and the new types of homelessness, in the framework of a continuum of processes and trends which cause both socially included and excluded people to experience important transformations as a result of the dynamics of social systems themselves. In this context, the emergence of a diverse typology of homeless female population is especially important. Homeless women display a whole set of shared problems and, while their male counterparts feel that the solution to their hardships lies in gaining access to the labour market, most women think that the way out of their situation requires them to find a house, a home, where they can live their own lives. In this sense, we have defended here the appropriateness of using the term “homeless” to speak about this social group, since it reflects better than others the deficits and shortcomings shared by "roofless" women and derived from their lack of participation in the community relations established within the framework of a household.
Of course, it is difficult to make any projections for the future of homelessness among women, a phenomenon which extends beyond national boundaries and requires international institutions to articulate corrective structural mechanisms associated with the implantation of long-term social policies.

References


Instructions to Authors for Word template

1. Locking of Copyright:

The copyright line is locked in the Procedia templates. The author may not edit the same and making it editable only PSMs. If there are any copyright changes required, you are requested to contact Journal Manager through Guest Editors. For editable the below mentioned steps must be followed:

Steps:
- Click on copyright statement
- Click on Properties in Developer tab
- Remove the checks from Content control cannot be deleted and Contents cannot be edited under Locking and then Press ok

2. Docm format:

We have added macros in the Word templates for the below mentioned features. And since macros are not supported in doc and docx format we created the templates of all Procedia titles in .docm format.

- Removal of all highlights
- Accept track change
- Locking of Rules

If .docm format needs to convert in docx format then the following steps must be performed:

Steps:
- Press Alt F11
- Click on Project (JID_Template)
- Enter "thomson" in Project Password
- Click on Microsoft Word Objects
- Click on ThisDocument under Microsoft Word Objects
- Delete all macros under General
- After deletion close the Code and Project (JID_Template) windows
- From File menu click on save as type .docx option

3. Comments added in the margin in Word master templates:

There are instances where author raising queries on what to do with key information lines such as “volume, page numbers”, “Conference title per issue” and “Copyright entity, year, copyright company Elsevier Ltd./B.V./Inc. and Organizer Name” in the copyright statement and for these concerns the comments have been inserted in the Word template to guide Author/JM about the information to be inserted by them in these fields.

Comments removal from Print: In Word 2007 and 2010 the comments present in a document get printed by default. If the authors do not want to get the comments appearing in print, the authors must remove the comments from the Word template before printing by changing the Print markup setting of word using the following steps:

Steps:
- Click the File tab
- Click Print
- Under Settings, click the arrow next to Print All Pages
- Click Print Markup to clear the check mark
Instructions to Authors pages to be excluded from Print:

- Click the File tab
- Click Print
- Under Setting, Type page numbers and/or page ranges separated by commas counting from the start of the document or the section. For example, type 1, 3, 1-5

4. PDF creation from Word master template:

While creating PDF from Word template the below given step should be followed to avoid difference in trim size and margin of the Word template and the PDF created.

Steps in Word 2007 and 2010:

- Click the File tab
- Click Save As
- Under Save as type, click the arrow next to PDF (*.pdf)
- Click Save

In Word 2003 the PDF can be created by using “Convert to Adobe PDF” symbol in tool bar or the required paper size can be adjusted in the Adobe PDF settings given in the Properties tab on the Print option.

5. Reference styles used in Procedia master templates:

<table>
<thead>
<tr>
<th>Title</th>
<th>Reference style</th>
</tr>
</thead>
<tbody>
<tr>
<td>AASPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>AASRI Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>APCBEE Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>EGYPRO</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>FINE</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>IERI Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>MSapro</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>PHPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>PIUTAM</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>Procedia CIRP</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>PROCHE</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROCS</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROENG</td>
<td>1 Numbered</td>
</tr>
<tr>
<td>PROENV</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROEPS</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROFOO</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROTCY</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>PROVAC</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>SBSPRO</td>
<td>5 APA</td>
</tr>
<tr>
<td>SEPRO</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>AQPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>UMKPRO</td>
<td>5 APA</td>
</tr>
</tbody>
</table>